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[1] Premise of using JSesh

1-1 Reading ancient Egyptian materials

yDocumenty
[Transiteraton] G40-S38-N29-029v-N35-16-Aal5-X1-049
transliteration ~
% [4 | -
G40 S38-N29 O29v N35 16-Aal5-X1-049
[Transfer] py yqy yy n (-'I') — km-t

* Not a precise transcription

[Language] Definite article: M.SG Ruler (M.SG) Great (M.SG) [-M.SG] = Egypt-F.SG
Ll
ysyntaxy Noun phrase

yreasony "Great ruler of Egypt"
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[1] Premise of using JSesh

1-2 Background knowledge when using JSesh

h number

transliteration
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[1] Premise of using JSesh

1-3 Hieroglyph number [1] Gardiner formula

Hieroglyph number

Basic framework

The Gardiner formula number is the 1928 + 1927 framework plus the number added in 1950.
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[1] Premise of using JSesh

1-3 Hieroglyph number [1] Gardiner formula

Hieroglyph number

Alan H. Gardiner (1928)

Catalog of the Egyptian hieroglyphic printing type. From matrices owned
and controlled by Dr. Alan H. Gardiner. In two sizes 18 point, 12 point with
Intermediate forms. Oxford: University Press.

Alan H. Gardiner (1927, 1st)

Egyptian Grammar. being an introduction to the study of hieroglyphs.
Oxford: Clarendon Press.

Alan H. Gardiner (1950, 2nd)

Egyptian Grammar. being an introduction to the study of hieroglyphs.
Oxford: Geoffrey Cumberlege, Oxford University Press.
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[1] Premise of using JSesh

1-3 Hieroglyph number [1] Gardiner formula

Hieroglyph number

A I Class A = people and their occupations

Gardiner type

about 751 types

G 1 7 Class B = birds
t 4

Norm
class
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[1] Premise of using JSesh

1-4 Hieroglyphica number [2] Hieroglyphica formula

Nicolas-Christophe Grimal, Jochen Hallof, Dirk van der Plas (2000, 2nd)
Hieroglyphica: sign list = liste des signhes = Zeichenliste. Utrecht, Paris:
Center for Computer-aided Egyptological Research.

Hieroglyphica type
(extended Gardiner

type) 4706 types B Y e B Y
N R EI P B P
A R B EIRAL:

WEB version https://hieroglyphes.pagesperso-orange.fr/Hieroglyphica%20=%20A.htm

Ten
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[1] Premise of using JSesh

1-5 Hieroglyph Number [3] Thot Sign List (TSL)

Hieroglyph number

A y

%ThotSign List lHome Browse Search About Contact
L

THOT SIGN LIST

Browse the list of hieroglyphic signs Search the list of hieroglyphic signs [Information about the project

@ 2021 - Thot Sign List v hlgghEe — 2 | Legals

https://thotsignlist.org
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[1] Premise of using JSesh

1-6 Transcription symbol: Manuel de Codage (MdC)

Encoding Egyptian transliteration
http://www.catchpenny.org/codage/#trans

'

MdC (Latin script)

3=A i=1 “=a w=w b=b p=p f=f m=m
n=n h=h h=H h=x h=X s=s §=8 k=¢q
k=k g=g =t (=T d=d 4=D

In this correspondence table, use MdC (Latin script) on the right side of = in JSesh.

[Important] Other correspondence between character numbers and MdC is posted on the following website.

Appendix B: List of sign numbers and phonetic values
http://www.catchpenny.org/codage/#app?2

12
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[1] Premise of using JSesh

1-6 Transcription symbol: Manuel de Codage (MdC)

Codes for arranging hieroglyphs in groups
http://www.catchpenny.org/codage/#groups

- |hieroglyphic sign separator  |i-ii-m-Htp

e

——
: |subordination of signs Y1:Z2 D
* |juxtaposition within a group |p*t:pt o
—

cluster positioning within a =

*(t- . D
() group p*(t:Z4):pt N
*

.+, () Can also be used in JSesh

13
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List of major 1 consonant characters

Hieroglyph

\\

Hieroglyph number

Z4

Translitertion

Translitertion . a
Font A | vy W W bb P
Y% J vy 1T y W W bb D
Ten 12 14 14 15 16 16 1717 1818
Hieroglyph - % MWW <> m ﬁ @ = ) e
ey RSt 19 G17 N35 D21 04 V28 Aal F32 034

h

Translitertion
Font

S

S

d

Font m n r S (Z)
,,,,,,,,,,,,, ffm n I H y X y X y zz
1919 20 sy one weywo | e ey ety i 26 27
Hieroglyph |] —1 A g | @ [ ; CS:-] i
PP RUTBEt S29 N37 N29 V31 W11 X1 V13 D46 110

K D

14
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[2] Use JSesh: Character input

2-1 Top screen of JSesh website

Documentation (operation manual) * You can

understand the operation method by reading here.

\-TS“.'E]I Releases News Artcles G|V_"|‘|'.:T,1‘f.1r:1r} Documentation Nutorials UgEs Morum ADoul Vi f

Download JSesh 7.6.6 | Source Code  Translileration

- .,:.‘;_";_ :"' ':‘_',-" .
T & oo B 2 =B
. Download JSesh 7.5.5
———— 3 .L:;. — .
-

JSesh

JSexh ix A wand processor, for ansent Fgeptian hierglyphic texis It's
used in many professional egyptal ngical publications: the IFAD, the JARCE, and all kinds of hanks.

= JScsh cexts can be copicd and pasted inco other softwares (as M5/ 'Word or Opepeffice), [t is also possidle 10 crearc pictures in various graphical formats (jpeg, pog,
pdf, swg, emf, macpict, etc...)

® i is s definitdy alluwed w wse JTSexh for pedilicerion. Mention af its use (in the same way one does mention fonts used in a book) would Te nice, Tut is not an absolue
requiremenl.

* JScsh 15 free: you can download and usc it at no cost, and give copics of it.

* JSesh is opensource: ite java code is freely available (under the CaCill license). 'or the user, it's definidy safer, as it means that, even if itz present suthor was
uni e 1 work on il other compuler scienlisls might take on the development,

Citing JSesh

If you use JSesh In a sclentifie work, you can reference it the following way :

Rosmordue, Serge, (20014). JSash Documenearion. [onlina] Available ar hipe//zechdoc ganherkhoneshed ore [Accassed 12 Jun. 2014].
R = —————=—

https://jsesh.genherkhopeshef.org
15
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[2] Use JSesh: Character input
2-2 Why use JSesh?

- Why Is It an app In the first place?

Can't it be displayed In font?

=

D A Not in series like

l:l Must be arranged like

Character typesetting is done inside rows / columns
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[2] Use JSesh: Character input
2-2 Why use JSesh?

- Hieroglyphs created with JSesh

Image (+ Unicode)
JSesh = Hieroglyph Editor
e Can be output in PDF format « Can

be pasted as an image in an application such as Word

e |t IS also possible to add annotations

<Applied technique>

-It Is also possible to output as Unicode format text.
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[2] Use JSesh: Character input

2-3 Starting JSesh and creating a new file

- Start JSesh 7.5.5

Mac version Windows version

This guide will explain the operation on the Mac version.
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[2] Use JSesh: Character input

2-3 Starting JSesh and creating a new file

When you start it, a new screen like the one below will be displayed (should)

Basic Mierngiyphs Zoom 200% v

1919
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[2] Use JSesh: Character input

2-3 Starting JSesh and creating a new file

. If the new screen does not appear

@ JSesh File Edit Window Help

New File (#N)

Create a new file with File> New

20
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[2] Use JSesh: Character input

2-3 Starting JSesh and creating a new file

of JSesh input screen

Cursor position (purple vertical line)

Hieroglyph display window

Type input box
Hieroglyph display zoom

nnnnnn



nslated by Google

[2] 'Use JSesh: Character Input

2-4 Hieroglyph input [See slide 14]

- [Method 1-1] Enter the "character number" in the type input box.

y Hieroglyphs are displayed

Cl-M17-D36-C43

Sasic Mierogyohs Zoom 800X B8

yEnter G1-M17-D36-G43 In the input box yConfirm with [Return]

* Enter in half-width alphanumerical

characters. * Use-(half-width hyphen) to separate characters.
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[2] 'Use JSesh: Character Input

2-4 Hieroglyph input [See Slide 14, Slide 12 Appedix B]

. [Method 1-2] Enter "MdC" in the type input box.

y Hieroglyphs are displayed

Basic Herogyphs Zoom 800 %

Enter Aiaw In the type input box

Even if you enter MdC, the result is the same as entering the character number.
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[2] 'Use JSesh: Character Input
2-4 Hieroglyph input

. [Method 2-1] Input using a palette

Window
> Hieroglyphs

Hieroglyph palette opens
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[2] Use JSesh: Character input
2-4 Hieroglyph input

. [Method 2-1] How to read the pallet

Family A. Man and his occupations

List of hieroglyphs

Sub-Family all

Sub-Sub-Family

Show all filter signs containing
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[2] Use JSesh: Character input

2-4 Hieroglyph input

y

g

Left click

(«

Once

.ethod 2-1] Palette operation: Select a character and check the details

y Detalls are displayed

y Select G
'_l <] [«ntmu Palette

Faruly G. Bed €]
Sub- Family 8]
Sub-Sub-Family e

& Show all filler siges containing Search

> = & &% %

s X2 ¥ ¥ %

I

L A w ok

Sub-Family

Sub-Sub-Family

Show all

Hieroglyphic Palette

Sign Description

~
v

filter signs containing Search

ol

26
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[2] Use JSesh: Character input

2-4 Hieroglyph input

. [Method 2-1] Palette operation: Select characters and enter hieroglyphs

Sign Description
Family C. Birds
Sub~Family all
Sub-Sub- Family

W
-
A
&

v Show all filter signs containing

- & % &%
E K ¥ %
OB o R
LA ek
% vllu-* g
y Left W click Ga3
(twice) o

G43

unmamed

i Mimoghen Zoom  A00 % [&]

y Hieroglyphs are entered at

the position where the cursor wag.

Basic Hieroglyphs Zoom B00% B

27
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[2] Use JSesh: Character input
2-4 Hieroglyph input

-thod 2-2] You can also enter hieroglyphs by clicking Basic Hieroglyphs * However, the
character types that can be entered are limited.

Basic Hierogiyphs Zoom 200% +-

Basic Hieroglyphs

28 28
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[2] Use JSesh: Character input

2-4 Hieroglyph input

A. Man and his occupations

D. Parts of the human bod¢

C. Rirds

K. Fishes and parts of fishes

N. Sky, earth, water

Q. Domestic and funerary furniture

T. Warfare, hunting, butchery
W. Vessels of stone and earthenware
Z Strokes

NU. Upper Cgypt Nomes
Low Broad Signs

Y Y Y VY YYYYAAYY

B. Woman and her occupations
E. E. Mammals

[Method 2-2] You can also enter hieroglyphs by clicking Basic Hieroglyphs.

29
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[2] Use JSesh: Character input

2-4 Hieroglyph input

When you enter in the hieroglyph palette, the

character number is displayed in the input box.

Summary of input in the type input box

v

caecermeer. V11 7-G43-19-G17-Q3-X1-N1

B iwfmpt-pt ‘

-ion character number Ime pt-N 1

The correspondence of N1 = pt is slide 12

See Appendix B

Both have the same result

%&zﬁ.&[gm

30
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[3] Use JSesh: Save the file

3-1 Save the file in JSesh format

JSesh  Fle Edit  Group Manpuation Sgn  Wirgow Helb
N

™0 Desktop

Cancel Save

(1) Save the file as "ex1" In y The extension to save
"Desktop" the file is .gly

31
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[3] Use JSesh: Save the file

3-1 Save the file iIn JSesh format

P Noa

M17-G43-19-G17-Q3-X1-N1

Basic Hieroglyphs Zoom 200% -

Click the file Input screen opens
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[3] Use JSesh: Save the file

3-2 Save the file in a format other than JSesh

n Wirdow  Help

File File
Impert ;
e
o > EXxport
Export as EMF
ke > Export PDF
expaort as SVG

Export as RTF

Export as HTML

Quick PDF Export O M
Sedect Quick PRF Export Folder

PDF / EPS output is recommended

unless you are particular about it!
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[4] Use JSesh: Combine characters

4-1 Target hieroglyphs

%F - & =
Create a hieroglyph like this

Let's paste it into Word or PowerPoint!

34
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[4] Use JSesh: Combine characters
4-1 Target hieroglyphs

- Grammar commentary

M17-G43-19

jw=f

main clause = 3SG.M

[Syntax] Adverb predicate sentence

"He Is In heaven"

G17

m =

To

0o

—

Q3-X1-N1

pt

Heaven-F.SG
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[4] Use JSesh: Combine characters

4-1 Target hieroglyphs

First, type in the following character numbers in the input box

M17-G43-19-G17-Q3-X1-N1

36
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[4] Use JSesh: Combine characters

4-2 Combination of characters using the type input frame

. Combine characters horizontally using *

M17-G43-19-C17-Q3*X1-N1

Basic Hieroglyphs Zoom 400 % o

Instead of a hyphen

Use * Q3 * X1 is one unit
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[4] Use JSesh: Combine characters

4-2 Combination of characters using the type input frame

. Combine characters vertically using :

E ex1l.gly

Hﬁg_&E

M17-G43-19-C17-Q3*X1:N1

Basic Hieroglyphs Zoom 400 % a

Instead of a hyphen
- Use . N1 goes under the

previous unit

38



[4] Use JSesh: Combine characters

4-2 Combination of characters using the type input frame

Je== Q3-X1-N1

QB*“_HD:Q‘ Q3 * X1: N1

T

' N1
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[4] Use JSesh: Arrange characters

4-3 Character combinations using menus

.ne horizontally from the JSesh menu

(1) Select a range of characters to be combined horizontally with the cursor

unnameaed

4§>.@_%zmal=l

M17-G43-19-G17-Q3-X1-N1
Basic Hieroglypks Zocom 200% i

y Select Group Horizontally

.' JSesh File Edit Group Manipulation Sign Window Help

Group Manipulation
Group Vertically %G
> Group Horizontally

Ligature Elements ®L
Ligature group with Hieroglyph ®K
Ligature hieroglyph with group #¥M
Explode Group OXE

40
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[4] Use JSesh: Arrange characters

4-3 Character combinations using menus

. Combine vertically from the menu

(1) Select a range of characters to be combined vertically with the cursor

unnamed

&\,@_mm

M17-G43-19-G17-Q3*X1-N1

Basic Hieroglyphs Zoom 200 % 8

y Select Group Vertically

.' JSesh File Edit Group Manipulation Sign Window Help
Group Horizontally 8 J

Group Vertically %G

Ligature Elements %L
Ligature group with Hieroglyph ®K
Ligature hieroglyph with group EM
Explode Group O¥%E

Group Manipulation
> Group Vertically
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[4] Use JSesh: Arrange characters

4-4 Change the writing direction

. In JSesh, the writing direction can be changed in each of the left yy

right and vertical yy horizontal directions.

Left writing (from left to right)

H% %D o

M17-C43-19-G17-Q3'X1:N1

Busic Feroglyphs Zoom 400 %

Right-to-left (from right to left)

B ergly

SY W, )

M17-G43-19-C17-Q3*X1:N1

Basic Hierogyohs Zoom 400 %

42
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[4] Use JSesh: Arrange characters

4-4 Change the writing direction

y Left horizontal writing setting (initial setting)

€ JSesth Fil&a Edit €

File File Horizontal writing

> Format ‘
> Text In Lines

S > |Left-to-Right-Text
o

Canter sral sgns
Justity test

Left writing

P NS
Left horizontal writing Q—-—.—z_ m

M17-G43-19-G17-Q3*X1:N1

Basic Hieroglyphs Zoom 400 %

43



Machine Translated by Google
[4] Use JSesh: Arrange characters

4-4 Change the writing direction

y Right-to-left writing setting

& JSesth Fla Edit G

File File Horizontal writing

> Format ‘

> Text In Lines

Tt s > Right-to-Left-Text

Taxt in Columns

| Left-to-Right Text

Center small sgns

Justity test

Right writing

s} (@) E ex1.gly

A __4
Right-to-left — _—

M17-G43-19-C17-Q3*X1:N1

5 Basic Hieroglyphs Zoom 400 %
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[4] Use JSesh: Arrange characters

4-4 Change the writing direction

. y Right vertical writing setting

File File Vertical writing

> Format ‘
> Text in Columns

> Ri%t-to-Left-Text

Right writing

00 BEargy

—>

M17 * G43

Right vertical writing

P |

=
<
4

At this time, let's combine M17-G43 in a 0
—

the horizontal direction!

ML7-CAS-19-C17-QI"XI N -! MIT*CAR-19-C17-QI*XINL -1

B Huroghprs Jogm R Huwroghypbs Joom

4545
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[4] Use JSesh: Arrange characters

4-4 Change the writing direction

y Left vertical writing setting

File File Vertical writing

> Format ‘
> Text in Columns

> |eft-to-Right-Text

v Lefi-to-Right Text Left erting

Left vertical writing %

M1T'GA3-19-C17-Q3"K1N]1-!

Basx Hereghphs Zoam 4

46
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[4] Use JSesh: Arrange characters

4-4 Change the writing direction

Please return to the left horizontal writing

T CE

M17-G43-19-G17-Q3*X1:N1

Basic Hieroglyphs Zoom 400 % -+
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[5] Use JSesh: Change the color of characters

5-1 Make the letters red

. y Select the range of characters you want to make red with the cursor

M17*G4AR-19-G17-Q3*X1:N1-!

Basic Hieroglyphs Zoom 400 % >

Range selection (purple)

48
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[5] Use JSesh: Change the color of characters

5-1 Make the letters red

. y Select Paint Zone in Red from the menu

i JSesh File Edit Group Manipulation Sign  Window  Help

Group Manipulation

> Paint Zone In Red

Shade Zone ace E exraly
Unshade Zone

'
Paint Zane in Black q %D [
—

Sr-M17C43-5b-19-C17-Q3*X1:N1-!

Basic Heroglyphs Zoom 400 %

49



Machine Translated by Google

[5] Use JSesh: Change the color of characters

5-1 Make the letters red

. The range of red characters can also be handled with the type input frame

[N

$r-M17*G43-5b-19-C17-Q3*X1:N1-!

Basic Hieroglyphs Zoom 400% B

$ r-range of red characters-$ b
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[5] Use JSesh

. Change the color of characters

5-2 Return characters to black

B JSesh File

. After selecting a range of

characters, select Paint Zone in Black from the menu

Edt Group Manipulation Sign

Group Manipulation

> Paint Zone in Black

b

Shade Zone ece = extoly
Unshade 7one

Paint Zone in Red q D ~
% l@ —

M17*C43-19-C17-Q3*X1 N1-!

Basic Heroglyphs Zoom

400 %

~
e

51
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[5] Use JSesh: Change the color of characters

5-2 Return characters to black

. If you delete $ r and $ b in the type input box, it will return to black.

= ex1.gly

L=

M17*G43-19-C17-Q3*X1:N1-!

Basic Hieroglyphs Zoom 400 % e

Delete $b

Delete $r
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[5] Use JSesh: Change the color of characters

. Let's make M17 * G43 red

[/ © E ex1.gly

)= B ==

$r-M17*C43-5b-19-C17-Q3*X1:N1-!

Basic Hieroglyphs Zoom 400 %

53
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[6] Use JSesh: Adjust the character spacing

6-1 Automatic adjustment between characters

File File

> Format

> Justify text

.t Justify text from JSesh File to adjust the spacing

Before adjustment

DR N

After adjustment

Rasi Meroghphs Toom BI0% a
A
2 |

Bask buraghphs Toom SIOX -~ ‘

54
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[6] Use JSesh: Adjust the character spacing

6-2 Vertical centering of subscripts

-t and adjust Center small signs from JSesh File

File File

> Format

> Center small signs

[ NE=
Before adjustment :

sk baregiphs Toom B0 % [ 2]
[ " |

leve 1

| NS
er adjustmen :

Bask Hareghphs foom BIO N e
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[7] Use JSesh: Copy and paste to other apps

7-1 Copy hieroglyphs

Select a range of hieroglyph images with the cursor

and copy with keyboard operation

* Right-click copy does not

' I:I seem to work
P =
—

A43-3b-19-C17-Q3*XLN1-!

y Move the cursor to the end point y Copy

with the keyboard

y Place the cursor on the start point and left-click

56
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[7] Use JSesh: Copy and paste to other apps
/-1 Copy hieroglyphs

- You can also copy from the menu

@ JSesh File Edit CroupManipulsiion Sign  Window =[] ® JSesh Fle FEdit CroupManipulstion Sign W

y Edit> Select All y Edit> Copy

57 57
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[7] Use JSesh: Copy and paste to other apps
/-2 Paste hieroglyphs into a word

. Open Word and keyboard / right click to paste

- o ‘ * When copying in words
w"—L WA BB FIIY LIFOF o Q BEFPLRb A #E | D axuh nght click works

v P (L

éf’? Qj I:’_T'l Cwaw

ASAIN  TFAo7—v=22 Adobe PLF O W& %
FEELUHT AW

Right click> Paste
Paste with keyboard

I NP

The Image Is pasted

.
~

58
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[7] Use JSesh: Copy and paste to other apps

7-3 Enlarging / reducing the pasted image

m—4L WA ®& FSFr> LAFOG Y WEFSAE = B axy =4 M B Ty LTI Y MEFLRp ity D asv)

" ¥ N\ 0 - P A - 5 - )
__Dv["?_ A v v / v U » )L —l -: — é;ﬁ n‘I'),

E : TG Gomssay | e
A=A '(f TS~ S -

B A% A TAIT—Y3Y S abe POF @ W&tk =Ab o | TEYR L A=l &

»

R

EIR" 0 I [ Py E 73-42 A B ——

Click the image and Can be scaled
click the y part in the image frame

59
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[7] Use JSesh: Copy and paste to other apps

7-4 Change copy format

. Change the copy format from the menu

Edit Edit

> Copy as

> Copy as PDF

Copy as RTF
Select etc.

Unless you are particular about it

It is recommended to paste the copy in PDF format into Word etc. *
Operation on Mac OS X

60
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[7] Use JSesh: Copy and paste to other apps

7-4 Change copy format

. Copy as PDF to PowerPoint

Geeboard

operation / right click to paste

If you can't paste

Try other formats such as
RTF (especially Windows)
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[7] Use JSesh: Copy and paste to other apps

7-5 Copy format and paste availability

. Mac OS X N

ormal C & P

Copy as PDF
C&P
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[8] Using JSesh: Exercises

8-1 Problem 1

. Enter the following phrase in JSesh

Document

Transcrpion G40-5S38-N29-029v-N35-16-Aal5-X1-049
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[8] Using JSesh: Exercises

8-2 Problem 2

- y Let's enter the following sentence in JSesh
APRNS
A [ |
) N
MWW
e Y

y Let's translate the sentence after pointing out the type of syntax
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XE
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XE
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[8] Using JSesh: Exercises

8-3 Answer to Question 1

Transcrpion G40-S38-N29-029v-N35-16-Aal5-X1-049
JSesh G40-S38-N29-029v-N35: 16: Aal5: X1 * 049

File File

> Format

Change to right-to-left writing

Vertical position centering Automatic

adjustment between characters
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[8] Using JSesh: Exercises

8-4 Answer to Question 2

@ % ADRa

M17-G43-19: D54-G43-G17-N25: X1 * Z1

I — A% 1 N

M17-G43-19 D54-G43 G1l7 N25-X1-Z1

jw=f jW-2 m = Yy s-t

main clause = 3SG.M coming: from the result phase [-3SG.M] = desert-F.SG
[Syntax] Intransitive verb, result phase, main clause
"He came from the desert"

[Explanation] In the main clause of the unfocused intransitive verb result phase, "jw + subject +

Use "verb (state form)"
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[8] Using JSesh: Exercises

8-4 Answer to Question 2

@ =0

M18-D54: N35: 19-G17-N25: X1 * Z1

P = | N
M18-D54-N35-19 G1l7 N25-X1-Z1
jj-n=f m = Jy s-t
coming: noun clause-perfect tense = 35G.M From = Desert-F.SG

[Syntax] Intransitive verb, perfect tense, adverb-focused, main clause
"He came from the desert."

[Explanation] "Verb-n + subject" (verb is complete) for adverbs focusing of intransitive verb result phase

Use the noun clause of the tense system). Adverbs focus with jw, the main clause marker

There is no. The adverbs that are focused are the prepositional phrases m yy s-t "From the Desert"
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[8] Using JSesh: Exercises
8-5 Gross

The gross used In this guide follows the rules presented in the following papers:

Camilla Di Biase-Dyson, Frank Kammerzell, Daniel A. Werning (2009)

Glossing Ancient Egyptian. Suggestions for adapting the Leipzig Glossing Rules.
Lingua Aegyptia 17: 343-366.

The translations of the grammatical terms used in Gross are as follows:

JEnglish languagey yJapanesey

ART article definite article

MCM main clause marker Main clause (marker)
NMLZ-ANT nominalization-anterior Noun clause-perfect tense
RES resultative

Result phase

* Since this guide deals with simple sentences, jw is uniformly regarded as the main clause

marker, but when it is followed by a suffix pronoun, it may be a subordinate particle (SBRD =
subordinate particle).
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